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1. Iniciar

1.1 Itens na Embalagem
Remova a sua Plotter i-Craft™ da embalagem e coloque-a em uma superficie nivelada e
estavel.

Verifique se os seguintes itens estdo na embalagem, caso algum item esteja faltando,
entre em contato com o seu revendedor.

Plotter de Recorte I-Craft™ (Lamina Inclusa) Folha de Adesiva 12" X 12” DVD de Instalagao

Cabo USB Cabo de Energia Pinga



2. Instalacao

2.1 Conecte ai-Craft'™

Certifique-se que a i-Craft™ esteja posicionada em uma superficie estavel. Conecte-a ao
adaptador de voltagem e a tomada de energia externa.

2.2 Instalagao da Lamina
Com o tempo de uso, a lamina naturalmente perdera sua eficacia e a

qualidade do recorte podera ser comprometida. E possivel atenuar esse
efeito aumentando a presséo de recorte. Porém, uma vez que a lamina esteja
totalmente desgastada e, ndo mais proporcione um recorte confiavel, ela
devera ser substituida.

Substituicao da Lamina
Empurre o pino na parte superior e empurre a tampa para tras para visualizar

a ponta da lamina. A seguir, utilize a pinga para prender a lamina usada e
remove-la do suporte. Pince a lamina nova e encaixe-a dentro do suporte.
Evite acidentes mantendo os dedos afastados da lamina.



o . : ha ,
A lamina tem um sistema de auto ajuste, portanto, nao necessidade de
ajustar manualmente o comprimento da ponta da lamina.

Para o recorte de vinil espesso fluorescente e reflexivo. E
também, para o recorte detalhado de vinil padrao.

Lamina
Padrao A lamina com tampa vermelha tem 45°, valor de compensacao
de 0.25 mm e didmetro de 2.5 mm
Para recorte de vinil reflexivo, cartolina, jateados, transfer e
Lamina recorte de precisao em esténcil.
Avangada
(Opcional) A lamina com tampa verde tem 60°, valor de compensacao de

0.50 mm e didmetro de 2.5 mm

S ———————




Instalagao do Suporte da Lamina
Insira o suporte da ldmina no carro de recorte. O anel externo do suporte deve

ser encaixado firmemente nas ranhuras do carro de recorte antes do

travamento do suporte. Inverta o procedimento para a remog¢ao do suporte da
l&mina.




2.3 Instalagao do Software “Sure Cuts A Lot”
2.3.1 Auto Instalagao

n Coloque o DVD de instalagdo no CD-ROM para iniciar a instalagao.
O software é compativel com Windows 7/8/10 e Macintosh OSX (10.6

-10.11).
ﬂ Click no Software e selecione “Sure Cuts A Lot” para dar inicio a instalagao.
> o
1-Q
* Video
e * i-Craft
- + Software
; * Install Acrobat 10.1.4
+ Back
Vist i-Craft website http://www.gceworld.com/fen/Vinyl_Cutter.php for more project video tutorials
Clique em “Next” para continuar.
3! Setup - Sure Cuts A Lot 4 o] & =

Welcome to the Sure Cuts A Lot 4
Setup Wizard

. (D ]l (2 " This will install Sure Cuts A Lot Pro 4,005 on your computer.

LX:G v f. Itis recommended that you close all other applications before
13\\/\0‘} #  continuing.

. et Click Next to continue, or Cancel to exit Setup.

[ Next > J I Cancel




Fl Selecione “I accept the agreement”

1 _ _1

15/ Setup - Sure Cuts A Lot 4

[E=8 HoN =

&

License Agreement
Please read the following important information before continuing.

Please read the following License Agreement. You must accept the terms of this
agreement before continuing with the installation.

Craft Edge Inc
End User License Agreement

Please read this License Agreement carefully before proceeding. This Agreement
licenses Software to you [either an individual or single entity] from Craft Edge and
contains warrant and liability disclaimers. By installing, copying or otherwise using

“‘Next.”

(18] Setup - Sure Cuts A Lot 4

e clique

Information
Please read the following impor tant information before continung.

When you are ready to continue with Setup, diick Next.

Craft Edge
Sure Cuts A Lot 4.0 Read Me

1. General Information

Thank you for choosing Sure Cuts A Lot. Sure Cuts A Lot i an axtremaly easy
orogram to cut virtually any shape with your electronic cutting machine. Cut
TruaType fonts, SVG files, images, & even draw your shapes giving you endless

this Software, you are confirming that you have read and understand this possbilites
IAgreement and agree to be bound by the terms of this Agreement. If you do not
agree with the terms of this Agreement, you should not install or use this
Software.

1 accept the agreement

_) I do not accept the agreement

Works with your installed TrueType & OpenType fonts on your computer
- Works with BossKut Gazele, Black Cat Cougar/Lynx, Craftwell eCraft, Pazzles
Inpsiration, Sihouette SD/CAMEO Portrait, Silver Bullet, USCutter, &more.
- Import various files formats, induding SVG & PDF
Drawing tools to draw and edit sahpes
- Weld overlapping letters and shapes together

<Back Next > Cancel < Back Next > \Cancd J

B Utilize a pasta “default” (sugerido) ou selecione uma pasta de sua preferéncia para
instalar o software “Sure Cuts a Lot” e clique em “Next”.

fg Setup - Sure Cuts A Lot 4

e e

&

Select Destination Location
Where should Sure Cuts A Lot 4 be installed?

Setup will install Sure Cuts A Lot 4into the following folder.

J

To continue, dick Next. If you would like to select a different folder, dick Browse.

: \Program Files (x86)\Craft Edg e Cuts A Lot 4 Browse. ..

At least 50.9 MB of free disk space is required.

< Back Next > j Cancel

ﬂ Marque “Create a Desktop Icon” caso queira criar um atalho. Marque
“Associated scut4 extension” para associar o arquivo de extensao “scut4” ao
Software “Sure Cuts A Lot”. A seguir clique em “Next” para iniciar a instalagéo.

FSF|

&

Select the additional tasks you would like Setup to perform while installing Sure Cuts A
Lot 4, then dlick Next,

15! Setup - Sure Cuts A Lot 4

=2

i

Select Additional Tasks
Which additional tasks should be performed?

Additional icons:

File extensions:

[V] Associate "scut4” extension

< Back ][ uext>‘] I Cancel
N




5! Setup - Sure Cuts A Lot 4 [E=]=

Ready to Install ‘
Setupis now ready to begin installing Sure Cuts A Lot 4 on your computer. @

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location:
C:\Program Files (x86)\Craft Edge\Sure Cuts A Lot 4

Additional tasks:
File extensions:
Assodate "scut4” extension

<Back Instal * Cancel

g

Nao marque “Install USB Driver”’, marque “Launch Sure Cuts A Lot” e
clique em “Finish” para concluir a instalagao.

15! Setup - Sure Cuts A Lot 4 = Ech B

Completing the Sure Cuts A Lot 4
Setup Wizard

1 K}@ “ Setup has finished instaling Sure Cuts A Lot 4 on your
8\ computer. The application may be launched by selecting the

<' %u@% (/‘ ./ instaledicons.
b\/\()‘) Clck Finish to exit Setup.
e al Install USB Driver

V| Launch Sure Cuts A Lot

ﬂ Execute o “Sure Cuts A Lot”.

Vanion 4006

E Clique em “Activate” para ativar 0“Sure Cuts A Lot”. E necessario estar conectado a
internet.

Sure Cuts A Lot 4 Demo Mode

“Sure Cuts A Lot 4" will run in Demo Mode until the software is activated
with a purchased License key.

In Demo Mode:

- The software will cut horizontal design as a
DEMO watermark.
- You can browse and purchase ddsi hape Store,

but will not be able to download to use them.

You can purchase a license at
hitp:#www crafted ge comipurchasedscal

(10| Digite o seu nome (em “Name”) e digite (em “Serial”) a chave do
Software de 25 caracteres que aparece na parte frontal da capa do
DVD. Clique em “OK” para concluir a ativacgao.
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e )
Activate Sure Cuts A Lot 4... (=3
Please enter your Name and Sexial.
Name: |GCC
Serial: 69212
Activation...
y e ) Thank you for activating the software.
. == If you need to move the software to a new computer, you can choose
7] Activate manually to Deactivate under the Help menu (Requires an Internet connection).
Uninstalling the software from a computer does not automatically
If you are unable to activate, check the Activate manu.a]ly option, and visit deactivate it.
‘hitp:fhwww crafted ge com cti o obtain your Activation code.
http:hwsrw crafted se com/activation/scal

m O “Sure Cuts A Lot” esta pronto para utilizado.

* | Some Cutt Aot & Urttted o
Fle fde Ober Dan Loy Dage EHeen Tewt View Cumes Wndew Help
Ascbma:  NaB@EL
rardes: basc -
e R |
= L dd L U T O - )
% | 1 P o 3 Oreeaton: Vertcal Purem) 3
K o ———
bl 3 _— ;
, 3 < Wdires SL0n
B - Sbdveor: 4 3
v |
ol 3 - —"
Z : . |== :
8 | S8CLOC0
N vyee | |
-

Obs. Caso esteja utilizando uma versao de teste para acessar imagens e nao
tenha digitado a chave do Software para ativar o "Sure Cuts a Lot",
conforme mencionado acima, havera duas linhas (marca d’agua)
cruzando a tela. Portanto, certifique-se de ativar o Software "Sure Cuts a
Lot" antes de qualquer atividade de recorte.

v

2.3.2 Ativagao Manual do Software

Caso o computador ligado a Ploltter i-Craft™ nao esteja conectado a internet
para realizar o processo de ativagao do Software descrito acima, é possivel
utilizar a fungao “Activate Manually” como alternativa ao uso direto da chave
de ativagao para iniciar o Software. No entanto, sera necessario providenciar
um outro computador com acesso a internet para obter a chave de ativagao
(“Activation Code”) seguindo as seguintes instrugdes:



n Marque a caixa “Activate Manually” e aparecera “Site Code” e “Activation Code”.
O “Site Code” ja estara preenchido e ndo podera ser alterado.

P

Activate Sure Cuts A Lot 4. (=)

Please enter your Name, Sexial and Activation Code.

Name: [k

Sextal:

Site Code: |62920-43822-24190-41512

Activation Code I

If you are unable to activate, check the Activate manually option, and visit
httphwurw crafted ge comfactivation to obtain your Activation code

hitp:iAww crafted ge comfactivation/scal

2 Acesse http://www.craftedge.com/activation/surecutsalot. Digite seu nome,
a chave do Software que aparece na capa do DVD e o “Site Code”.

Clique em "Generate Activation Code" e o seu codigo de ativacao
aparecera em “Activation Code”.

ﬂ Copie e cole o “Activation Code” na caixa de diadlogo do Software “Sure
Cuts a Lot” e clique “OK”.

2.3.3 Reinstalagado do Software “Sure Cuts a Lot”

Caso haja troca de computadores, sera necessario desativar o seu Software “Sure Cuts
a Lot” e reinstala-lo em outro computador.

11



Escolha “Deactivate” em “Help”, clique “Yes” para confirmar e siga os procedimentos
de instalagdo utilizando o mesmo codigo para ativa-lo no outro computador.

5] Sure Cuts A Lot 4: Untitled
File Edit Object Path Layer Page Effects Text View Cutter Window
About Sure Cuts A Lot 4...
Help F1

Online Forums

Online Video Tuterials...

Install Driver...

Support »
@ Register Product
[, e Check for Updates
& [ i I Deactivate... I
o i
;’ﬁ Deactivate \?J

Are you sure you want to deactivate the software?

Deactivating will allow you to re-install on a different computer.
(Requires an Internet connection)

[ewl o]

2.3.4 Como dar um “Reset” na licenga do “Sure Cuts a Lot”.

Como dar um ‘“reset” caso seu computador ndo tenha o “Deactivate Flow”?
Siga as instrugdes abaixo:

il Clique no web site

Sure Cuts A Lot 4 Demo Mode Activate Sure Cuts A Lot 4... E]

"Sure Cuts & Lot 4" will run in Demo Mode until the software is activated

Please enter your Name and Sexal.
with a purchased License key.
Name: [ ‘
In Demo Mode:
- The software will cut horizontal lines through your design as a Serial: “ ‘
DEMO watermark.

- You can browse and purchase designs from the eshape Store,
but will not be able to download to use them,

mIVR—

If you are unable o activate, check the Activate manually option, and visit
hitp:/Avww crafted ze.comdactivation o obtain your Activation code.

[ Activate::. ] Il oK i Ih@:ll\vww.cﬂhd@mum_fﬂ'vaﬁnn}md l

ﬂ Clique em “De-Activation Page” no meio da pagina.



Important: You only need to do the following if you are having trouble activating from within "Sure
Cuts A Lot" or do not have an Internet connection on the computer you are trying to activate on.

You must activate in order to use the full version of the software. Generally, you will just need to
choose Activate.. from the Help menu in Sure Cuts A Lot and enter your name and serial number.
The software will try to activate automatically and you can disregard this web page. Do not use this
web page if you have not installed the software yet or have not purchased.

If you view the About box in Sure Cuts A Lot and it shows your name and serial number, the software
is activated ok.

If you have problems activating automatically, you must use this web page and generate an
Activation Code. The Name and Serial information is obtained from your purchase confirmation
e-mail. The Site Code is obtained by running the program and choosing "Activate..” and checking the
"Activate Manually” option.

Standard Activation Video Tutorial
Manual Activation Video Tutorial

I Please go to tl"|-e De-Activation Page for de-activating or resetting your serial number. I

Name: {Anderson |
Pesas enter your it name

Serial: [76059-21482-39485-44333-51109 | what is this?
(example: 12345-12345-12345-12345-12345)

Site Code: [62392-68615-57113-53612 | what s this?

Generate Activation Code

After entering in your Name, Serial, and the Site Code, click the Generate Activation Code button to
create your Activation Code. Copy and paste the value back into the "Activation" dialog box in the
application to activate your copy.

If you experience problems generating your Activation Code, please see our FAQ.

. Digite a informacéao do registro original, 0 numero de série € 0 motivo do “Reset” da
licenga.

tivate Sure Cuts A Lot

Please enter your Name and Sexial.

Name: [Anderson I
Serial [77165-26182-58435-09271-53419] }
[ Activate manually [ Cancel ] [ OK ]

If you are unable to activate, check the Activate manually option, and visit
hitp:/Awvew crafted ge comfactivation to obtain your Activation code.

http:Awwew crafted ge comfactivationsscal
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Deactivate "Sure Cuts A Lot"

This page can be used to reset your serial number if you need to re-install the software again due to
problems such as a computer crash/reformat where you were not able to de-activate your copy off
the computer first.

If you still have an activated copy installed and you wish to deactivate to install on a different
computer, you can choose Deactivate under the Help menu in Sure Cuts A Lot 2 instead of using this
webpage. The deactivation option in Sure Cuts A Lot requires an internet connection.

Important: You will only be able to use this page on a limited basis to reset your serial number. If
you need your serial reset again after using this page, you will need to contact

support@craftedge.com for help.
1P Address Logged: 60.248.24.232

Name: [Anderson |

| chen@gcc.com.tw |
Serial [76059-21482-39485—44333—51 109 |

Email

I Please describe the reason you are needing to reset your serial number I

E] O numero de série pode ser digitado apos o procedimento "Deactivate" no

web site.

Deactivate "Sure Cuts A Lot"

This page can be used to reset your serial number if you need to re-install the software again due to
problems such as a computer crash/reformat where you were not able to de-activate your copy off
the computer first.

1f you still have an activated copy installed and you wish to deactivate to install on a different
computer, you can Deactivate under the Help menu in Sure Cuts A Lot 2 instead of using this
webpage. The deactivation option in Sure Cuts A Lot requires an internet connection.

Important: You will only be able to use this page on a limited basis to reset your serial number. If
you need your serial reset again after using this page, you will need to contact
support@craftedge.com for help.

1P Address Logged: 60.248.24.232

Serial has been reset and you should be able to use it again now |

Name [Anderson |
Email anderson.chen@gcc.com.tw ]
Senial 176059-214&2-3948544333-51109 ]

Please describe the reason you are needing to reset your serial number

PC Format
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2.4 Instalagao do Software “GreatCut”

n Clique em registro do “GreatCut” no DVD de instalagédo para acessar
http://gccvoucher.eurosystems.lu/.




A seguir digite o seu “Voucher Code” (informado na compra do
“GreatCut”) e clique em “Go on!”

i-CRAFTTM

www.GCCworld.com * # + + # « Turn yourcreativity into reality

+ Video
+ i-Craft

*+ Software

Install Sure Cuts A Lot
# §=C Sure Cuts A Lot User Manual
Sure Cuts A Lot iPad User Manual

% |nslnstall GreatCut
GreatCut Registratio ,
\GreatCut User Manu%.?
o GLC..

Vist -Craft website http://www.gccworld.com//goods.phpact=view&no=47 for more project video tutorials

Great Computer Corp. Software Voucher Code “c G@E GJt

ETONET

r

Please enter your voucher code completely and accurately as it stands on the voucher.

Voucher Code [KGCC-R0NXOKGRKG| |

Go Onl >
In case of problems or questions Ysu can reach our technical support over tech.support@acc.com.tw.

[Homepage Great Computer Corp. |

ﬂ Clique “Request” para acessar a pagina de registro.
Great Computer Corp. Software Voucher Code xc Greot GJt

You are holding in your hands a software voucher for a full license of GreatCut 3.
In order to receive the free of charge license code and download GreatCut 3, please use the following button:

License code for new full license \%

[Homepage Great Computer Corp. ]




Preencha o formulario e clique em “Request License Code”

Software Download GreatCut 3

Great Cut

Software Registration

Last name, first name: [Eileen ! 1 Required fields

uld y:
Company: |GCC
Street: 4F-1, No. 236, Fude 2nd Rd., Xizhi Dist. !

PO box:

City: |[New Taipei City !

State/Prov.: | (only US and Canada) v
Zip (postcode): 22151 '
Country: | Taiwan v 1

Phone: |886266166692 !

Fax: |

elMail address: |e|leen chen@gcc.com.tw !

Imgort

| Request license code >

N

Pl Vocé recebera dois e-mails: um confirmando o registro

com o link de ativagao, e o outro com os dados da licenga e arquivo .ecf

Registration Successful

Thank you, that you decided for GreatCut 3.

An email with further information for GreatCut 3 was sent to the given email address (eileen.chen@gcc.com.tw). Please be
patient, as it may last up to 30 minutes until you can receive this email.

If you dont receive an email, please fill out the form on gccvoucher eurosystems lu again with a working email address.

[Home Great Computer Corp. |

B Verifique o recebimento do link de ativacdo no seu e-mail. Clique no link para o
fazer o download do “GreatCut”.

SHE tech.support@gec.com. tw
gz =—o eileen chen@gee com.tw
b

=5 GreatCut 3 - Activation Link

Dear Customer,

thank you. that you decided for GreatCut 3.
Please click the following activation link or enter it in your web browser:

http://gccvoucher.eurosystems lu/activate.dmli?id=128461259209629vul FO0aiKeRkhOg;

After clicking the link. you immediately will get download links and license data for GreatCut 3.
If you have questions. you can reach our support over tech.support@gcc.com.tw.

Best regards
Great Computer Corp.

E Ou clique “Install GreatCut” no DVD de instalagao.



i-CRAFT Lot

Www.GCCworld.com *+ = & = Tunn your creativity into reality.

* Video
* i-Craft

* Software
Install Sure Cuts A Lot
% j-C Sure Cuts A Lot User Manual
Sure Cuts A Lot iPad User Manual
% Ing!nstall GreatCuty,
GreatCut Regiswation
\GreatCut User Manual

» Bacn

Vist i-Craft website http://www.gceworld.com//gaods.php?act=view&no=47 for more project video tutorials

Selecione uma pasta de arquivo.

Biowse

Innsta 1Sfield

Cancel

Bl Selecione “Typical” e clique “Next’.
Obs.: Selecione “Custom Setup” para instalar drivers adicionais.

IristallShiield < Back Mext> Cancel

ﬂ Selecione a pasta e clique “Next”.
A pasta padréao do Software no menu “Start” € GCC\GreatCut 3
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Great Gut

Setup Status

Administrative Todls
ASLIS Utily

Bulzip

Catalyst Contral Cenler
CorelDRAW Graphics Suite X7
Craft Edge

Express Gate

Games

Goagle Eatth Pra
1Zhic

Java

< Back MNext >

Irisk

InstallShield Wizard Complete

Th nd

< Back Firish

Cancel




Antes de iniciar o “GreatCut”, abra o .ecf anexado ao e-mail contendo as
informacdes para instalar os dados da sua licenga ao “GreatCut”.

= RCS-ONLINE «directiownload @eumsystems >
= eileen chen@gee com tw

S

Ht W 5 o

B GreatCut 3 - Receipt and License code

a| [ ocihias7ed 2736)

GCC... GreatGut

1. Please print this eMail.

2. License data for GreatCut 3

-
The following license code will be activated by copving or saving the att

-
e Live Update: — u

For a possibly necessary manual input, here the license data (green) again|

License installed successfully.
Company / Name: GCC
eMail:
Code:

cileen chen@gcc.com.tw

GC16P-BMDL-BVAC-SJFC-VTWY-RHZS
Number of Licenses: 1

| |
Serial No.: GC16P-1867

Caso nao obtenha sucesso na instalagao da licenga, sera necessario preencher os
dados manualmente. Todas as informacgdes da licengca constam no e-mail.

Note:

Please fill out the fields of the license data exactly as you
received it.

Company { name:

jocC

ebail:

[ke_i.ra.lee@gccxom.m

Code:
[KGCC-REXEE-XXXXL-KH N E-XHARK
System information PIN:
|3666223326-0-9-1-57-MARKET-KEIRAZ

o

Fe45:  RCS-ONLINE <divectdownload @eurosystemns ns FerOE:
Ly = etleen chen@gee oo by

2015/2/25 (G
&

F5:  GreatCut 3 - Receipt and License code

TIRE ccee-1a67ec (273 D)

The following license code will be activated by copying or saving the attached file to the computer and starting it via double click. Thus the
activation is done fully automatic and GreatCut 3 is ready to use.

For a possibly necessarv manual input, here the license data (green) agzain in plain text:

Company / Name. GCC
eMail:

Code: _

Number of Licenses: 1

Serial No.: GC16P-1867
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GreatCut 3

GreatCut 3
Version 16.0.2.10918

1 Greot Cut

Copyright c EuroSYSTEMS 1991-2014

2.5 Instalacao do App para Tablet

Procure “Sure Cuts A Lot” na Apple Store e cliqgue em download e instale. A
seguir, utilize um ponto de acesso “wireless” como o Apple AirPort Express™
para conectar o Tablet a i-Craft™.

. .
. E
. .
. .
. P .
Sure Cuts A Lot
f la

AirPort Express

O exemplo a seguir, utiliza o AirPort Express™ para estabelecer um ponto de acesso
“wireless” para o comando de recorte através de um tablet.
2.5.1 Configurar um Ponto de Acesso “Wireless”

1] Compre o “AirPort Express™ na Apple Store, fagca o download e instale o
“AirPort Utility” do Web Site da Apple.



AirPort Utility software and firmware downloads

AirPort software

Software 0S Required  Compatible AirPort Products

AitPort Express 802 11n (2nd Generation), AlrPort Extreme &

ﬂ Conecte o cabo DSL 6u o cabo db modem acﬁu “AirPort Express” utilizando o
“‘WAN Ethernet Port”.

,..'h-
-

m oo miall;
L

Utilize o “AirPort Utility” para criar uma nova rede de comunicacgao.
Informagdes contidas no manual do “AirPort Express™.

(Imagem obtida do Apple website)

4 Ap6s concluir a configuracdo, as luzes do “AirPort Express™ e do “AirPort
Utility” na janela de configuragéo, passarao da cor verde para a cor laranja.

Aebon Utiay =R

Fle BaseSutien Setings  Mep

et Uity found
Name: AcPort Dxpress.
PAdTes: 192.163.300.244
versore 764
Aebort i 6CMAFEDLB L

11998 1 the APt wiraless device v WAL 15 562 0, YOU €O SAACT MY o the It on e et 1f
7o dont see 1, mabe sure 118 phgged i and s range of your computer

| TelaLCD |

- e |  Pausa |
3.0peracao

de Controle
/

3.1 Painel

23 \
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LED Pausa/Erro

Power LED
Enter

Recorte
Feed/Eject

Tecla Funcao

Liga/Desliga (Power) | off =» Desligado

on =» Ligado
4 Setas Posicionar, selecionar fungao, alterar configuragao
Enter Estabelecer um item ou registrar a entrada de

informacéao precedente.

Pause Interromper temporariamente ou dar continuidade ao
processo de recorte
Cut - Fazer o recorte

- Repetir o ultima trabalho de recorte

Feed/Eject Carregar/Ejetar a midia

LED Indic. Cor Funcgao

LED Power | Verde Aceso = Ligado
Apagado = Desligado
Piscando = Em

Operacao
LED Vermelho | Aceso = Pause
Pause/Error Piscando = Erro

3.2 Configuracao do Painel de Controle

As opcoes de configuragao “Origin settings”, “Advanced settings”, “Media”, e
“USB Drive” aparecerao na tela LCD. Pressione as teclas com setas para cima
ou para baixo para a movimentagdo dos pontos de marcagado e pressione a
tecla “Enter” para dar entrada nas configuragcbes do menu.

Obs.: As opgdes “Media”, e “USB Drive” aparecem quando o drive USB e as
instrucdes para “Media”, forem conectados. Consulte o capitulo 5 sobre a
utilizagdo do drive USB com a i-Craft™.



Mzin Menu Main Menu
e0Origin settings

Adv. settings

e0rigin settings

v

3.2.1 Configuragdes de Origem

Caso queira recortar formatos diferentes na mesma midia, € possivel utilizar a
funcdo “Origin Settings” para dar um “reset” na origem, evitando assim, o
desperdicio de material.

Posicione o ponto de marcagcdo em “Origin Settings” e pressione a tecla “Enter”. As
configuragcdes aparecerao como mostrado abaixo. Utilize as setas para obter o
posicionamento desejado e pressione “Enter” para estabelecer a origem.

Main Menu Move Orxigin
e0Origin settings
Adv. settings A
> E >
v
A YV Ok: 4 ~1 |

3.2.2 Menu Para Configuragao Avangada
Menu de Funcéao Conf.
Conf.
Avancada.

Para contornos suaves ao recortar ou desenhar| Habilitar
circulos ou curvas. Caso queira recortar linhas curvas,| Desabilitar
sugerimos habilitarar a fungdo “Smooth” para recortes
de contornos mais suaves.

Suave
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Para formas mais elaboradas, sugerimos desabilitar a
funcdo “Smooth” para um resultado de melhor
qualidade.

Tipo de Midia

Escolha entre Rolo (“Roll”) ou Folha (“Sheet”).

Roll, Sheet

Suporte

Posicione o suporte no carro de recorte conforme a
necessidade. Caso selecione “Pen”, o suporte ira
recuar 3 cm. Em “Blade” ou “tool”, o suporte volta a
posicao original.

Blade,
Pen, Tool

Economia de
Energia

A i-Craft oferece o0 modo de economia de energia que
pode ser configurado para desligar a maquina
automaticamente caso nado esteja sendo usada. O
tempo de atuacdo vai de 30 a 500 segundos apés a
maquina estar parada. Quando o modo estiver ativado
a luz de fundo da tela apagara e acendera novamente
guando a maquina voltar a operar.

Desliga
30 - 500
segundos

3.3 Carregamento da Midia

n Posicione a midia na folha adesiva e alinhe a extremidade da folha adesiva

a parte esquerda e a parte superior da linha de grade.

)
|




E Gire a alavanca no sentido anti-horario para liberar e movimentar o rolo de pitada a posicao
de recorte desejada. A i-Craft™ recorta diferentes tipos de midia, incluindo Letra, 9 polegadas,
A4, A3 e de12 polegadas.
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o > F > YUU walil arnu LA LI ure v, s ‘
sject button @ to unload the media
» Remove the media from the adhesive sheet and the job is done.

ob is done.
DMAslilv('umh . w Adhesive Sheet
Sl =

LS

Gire a alavanca no sentido anti-horario para fixar o rolo. Press. Feed/Eject

28




i

= Fe Fix !

ﬂ A extremidade da midia do lado esquerdo deve estar alinhada com a primeira linha a

esquerda do rolo frontal.

)
8.

Firstline

(o)
(o)
o}

of Front
platen

[E Abaixe a tampa frontal para evitar acidentes.

3.4 Config. do Link com a i-Craft™

n Coloque o software “Sure Cuts A Lot” em execucéo.

E Selecione “My Cutters” sob “Cutter” na barra de ferramentas e selecione
“GCC i-Craft.”
|~ Sure Cuts A

File Edit Object Path Layer Page Effects Text View | Cutter | Window Help
3 \ | 1] D o (. [ Mat Size
& D =] ‘ 'i F—. Mat Orientation

Preview Ctrl+Shift+P

Cut with GCC i-Craft
Cutter Settings..

My Cutter \ » Manage Cutters...
Tablet Connection... v GCCi-Craft
i — @1 Gce \

Selecione “Mat Size” sob “Cutter” para config. a area de trabalho.

29
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 File Edit Object Path Layer Page Effects Text View [Cutterl Window Help

Mat Size > | V| 12"x12"
Mat Orientation \ 12"x24"
Preview Ctrl+Shift+P ot
A3 (29.7x42 cm)
Cut with GCC i-Craft Ad (213297 cm)
Cutter Settings.. =
i My Cutter < Custom Size...
Lo booa b b bown bown bvwn b by
Tablet Connection...
E Selecione “Mat Orientation” para alterar a diregdo da area de trabalho:

horizontal ou vertical (vertical € mais comumente utilizada).

File Edit Object Path Layer Page Effects Text View [Cutter| Window Help

Mat Size 4
Mat Orientation » Horizontal (Landscape)

Preview Ctrl+ Shift«P v Vertical (Portrait)

Cut with GCC i-Craft

. .
0 1T 2 3 A s 6 7 8 My Cutter L2

» >

Tablet Connection...

3.5 Edicao do “Sure Cuts A Lot”

Siga as instrugdes abaixo para operara a Plotter com o software “Sure Cuts A
Lot”. Caso necessite de instrucdes detalhadas consulte o “Sure Cut A Lot
Help”. Se estiver usando a versao SCA para Tablet, siga as instrugdes abaixo,
porém, nem todas as funcdes poderao ser executadas no tablet.
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File Edit Object Path Layer Page Effects Test View Cutter Window [Help |
About Sure Cuts A Lot 4...
Help
Online Forums
Online Video Tutorials...

Install Driver...

0 Ttz 3 s s 6 78 s 10 1 Support

[ S W I B AT I A PP AT IO I Register Product

Check for Updates

About "Sure Cuts A Lot 4"

Thank you for choosing "Sure Cuts A Lot 4", "Sure Cuts A L ot 4” is an extremely easy peogram to cut youe fonts and various shapes using vasious electonic cutting
machines. With the combination of using your Fonts, importing custom artwork and drawing your own shapes, the possibilities are endless!

Features

Works with your inetalled TrueType and OpenType fonss on your computer

Works with Black Cat Cougan/Lynx™ , Bosskut Gazelle™, Cratiwell eCraft™, CraftROBO/Graphtec™, GCC™, Foison™, Liyu™, Fazzles Inspisation/Pro™,
Ramtin™, Roland ™, Seki™, silhouetie SDICAMEO/Fortrait™, Silver Bullet™, USCutter™, Vinyl Express™, Wishblade™, & more
Works with thousands of free TrueType, OpenType and Dingbat/Wingding fonts

Import various file formats, including SVG, FDF, EPS, WPC

Drawing 1cols to draw and edit shapes

Auto tracing feature to automatically convert images (including jpg, bmp, gif, pug) for cutting

Create rhinestone templates and lattice shapes

Print % Cut

Weld overlapping letiers and shapes together

Select styles, including Shadow and Blackout, to change the look of your letters and shapes

Cut additional shapes from the "Sure Cute A Lot” Libeary

WYSIWYG Interface - What you see i3 what you cut

Available for Windows and Macintosh OSX

System Requirements

o (Win) Windows Xp/Vista/28

o (Win) Intel Pentium or equivalent processor
o (Mac) Mac OSX 106 - 10.10

o (Mac) Inte] based processor

o S12 MBof RAM or grealec

* S0 MB of available hard disk space

o USB Poat L1 o¢ 2x

3.5.1 Utilizando a Biblioteca

3.5.2 Texto

Clique no icone “T” no lado esquerdo, selecione a fonte na janela de textos.

File Edit Object Path Layer Page Effects Text View Cutter Window Help

1
1 1

Tracking: 10000 % 14
Leadng:  0.00in 1+

VOffset: 0.00in (2]
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3.5.3 Para Importar Design

Caso tenha criado seu design em outro software, selecione “Import” sob “File”. O
SCA aceita os seguintes arquivos: svg, scut, scal, pdf, ai. eps, png and wpc.

I
1 Sure €1t A Lot & Unttied E)EED

Fle Fet  Obgact B0 Loyw Bage Eecs  Toat View Cumtwr Whindow Help

A% o BIEG I S A

JIsBUNONEC\ N |1 700




-
5| Sure Cuts A Lot 4: Untitled

Edit Object Path Layer Page Effects Text View Cutter Window Help
New Project Ctrl+N 1 =
1| L [ a T Q
Open Project Ctrl+O !’;“’ F- E E
Save Project Clrl+S
Save Project As... Ctrl+Shift+5
Import... Ctrl+Shift+
Export... Ctrl+Shift+E 2
Trace Image... Ctl+ Shift+ 8 s
Place Image... -~ LT
(e O b L D e e e B Do DA T T el e )
Send to »
eshape Store...
Share Project...
Sync My Library...
Print Setup...
Print...
L
Recent Projects 3
Exit Ctrl+Q [
- ¥ IR L
Network
Pl rane; .
Flesoftype: Al Readable Fies. % Concel
3 Scalable Vector Files (*sva, svgz)
[ s i Sure Cuts A Lot Projects (*scut, *scut2, *scut3, *scutd)
- Sure Cuts A Lot Design (".scal)
< PDF Files (*.pdf)
A, ¢ Adobe llustrator Files (*i)
¢ s EPS ("eps) e
I ¥ PNG Files (*png) e
i WPC Files (*wpc) pes

Milhares de arquivos SVG especialmente projetados para serem
usados com o software “Sure Cuts A Lot” (http://SVGCuts.com).
Milhares de elementos de alta qualidade para fazer cartdes, albuns de
recortes, embalagens p/presentes, caixas e flores em 3D. Os arquivos SVG
tém download gratuito. Somente alguns arquivos, para trabalhos mais
delicados, tém algum custo. Prepare-se para obter resultados maravilhosos!

3.5.4 Camada de Sombreamento (Recorte de Contorno)

A opcéao “Shadow Layer” acrescenta uma camada que gera um contorno ao redor do
objeto selecionado. Para acrescentar uma camada de sombreamento selecione
“Shadow Layer” do menu “Effects”.
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- _ B
£ Sure Cuts A Lot &: Untied N
S (/’ Shadow Layer |88 |
File Edit Object Path Llayer Page [Effects| Text View Cutter Window Help

aal 3D Rotate 4
Barrel Distertion Type: [shadow v]
Bulge _—
Canned size: | | 0.09in Z
Knockout
) I Miter:  1.00 |4 Color: .
== Lattice... . >
“ L e | ["1nset Shadow Layer count: 1 2
' Object On Path
5 | Pierce | [] Blackout Shadow Layer size variance: | 1.0 -
Puzzle Generator
T, | SR [T Print-+Cut Outline End Color: .
o 2 Shadow Layer (Contour Cut) ...
Title Crawd
& | Wie Cancel ] [ OK ]
s | Wrapper
K b

Size: Determina a abrangéncia do sombreamento sobre o objeto.

Miter: Controla a mudanca de cantos pontiagudos para chanfrados, ao utilizar
o “Shadow” padrao.

Insert Shadow: Caso esteja marcado, o0 sombreamento sera inserido.

Blackout Shadow: Remove contornos internos.

Print+Cut Outline: Configura a camada de sombreamento gerada para o tipo
de linha do “Print+Cut Cut” e estabelece o formato original para “Print+Cut
Print”. Dessa maneira, o formato original serd usado somente para impressao
€ a nhova camada de sombreamento sera usado somente para recorte.

3.5.5 Conversao de Imagem ao Arquivo de Recorte (Tracado de Imagem)

O "Sure Cuts A Lot" permite a importagao de arquivos de imagens e faz o tragado da
imagem para recorte.

n Selecione “Trace Image” sob “File” ou selecione “Trace Image” na barra de
ferramentas.
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] Sure Cuts A Lot 4: Untitled
Edit Object Path Layer Page Effects Text View Cutter Window Help

New Project Ctrl+N

Open Project Ctrl+0

Save Project Ctrl+S

Save Project As... Ctrl+Shift+S

Import... Ctrl+Shift+]

Export... Ctrl+Shift+E

Trace Image... Ctl+Shift+B I Lt

Place Image... _ e

sandto , [ N G A Oy B WS R YO

E Clique em “Choose an Image” para inserir a imagem, ajuste o “Image
Settings” e o “Output Settings” e cliqgue em “OK”. O contorno da
imagem sera inserido automaticamente.

e Output
. l I [”] show Nodes Nodes:
Choose an image Show Source Image: {1
R Q@

Configuragao de Imagem

Mode: Seleciona o modo de trago

Monochrome - Para obter tragco em preto e branco.

Contraste: Determina o limite de trago nas imagens. Quando acionado a
imagem anterior mudara para preto e branco mostrando qual partes da imagem
serdo tracadas. Para conferir os resultados do traco, clique em “Update
Preview” .



Output
[T Show Nodes Nodes: 222

I g poslt trace image.jpg

(715x 727)

Show Source Image: {1 N

Image Settings

Use Alpha Channel
Mode: Tl ahen avaiabe)
Contrast (0-100): — 221 |
Output Settings

Smooth (0-100): 75 |
Detail (0-100): 98 )

Single Line Threshold: 0

4|j

[ Break Apart Outlines [ Blackout
Update Preview

[ Add Image Layer (Print+Cut)
i

[ Restore Settings ] [SaveasSVG...]

Color layers: — Segmenta a imagem na quantidade de cores especificada.

Max Colors: Exibe a quantidade maxima de cores de segmentacéo. Para
desabilitar cores clique na caixa de cores. Para conferir o resultado obtido,

cligue em “Update Preview’.

Output

Dlshontodes  Nodes: 11811
I trace image.jpg Show Source Image: {1} "
e
s
@

Image Settings

o

Max Colors (2-256): {

Output Settings
Smooth (0-100): 75 <=

Detail (0-100): 98

Single Line Threshold: 0 wal
< \j )
[] Break Apart Outiines [~ Blackout
[] Add Image Layer (Print+Cut)
i

[ Restore settings |  [saveas svG... |

Single Color - Para escolher uma cor especifica para o trago clique na
cor desejada e em “Preview Image”.

Contraste: Veja acima



# Tracelmage

Input Output
[ choose an image... | [ Show Nodes Nodes: 211
trace image.jpg Show Source Image: {1
(715x 727) @ @ @

Image Settings

Mode: {Slngle color v

Contrast (0-100): {1 5

Output Settings
Smooth (0-100): 75

Detail (0-100): 98
Single Line Threshold: 0 < -

| Break Apart Outlines [~ Blackout

| Add Image Layer (Print+Cut)

Restore Settings ] i Save as SVG... ] Cancel l OK

Configuracoes de Saida

Smooth: Quanto maior o valor selecionado, mais suave sera o traco.

Detail: Valores menores removerao formatos menores.

Single Line Threshold: Utilizado para o trago de imagens que nao tenham
formatos de contorno com preenchimento sélido, impedindo assim, linhas
duplas.

Break Apart Outlines: Quando marcado, o resultado do traco sera salvo
em camadas separadas para cada contorno criado.

Blackout: Remove os contornos internos.

Add Image Layer (Print+Cut): Acrescenta a imagem fonte como uma
camada sob o contorno tracado e coloca a camada do contorno tracado em
“Print+Cut Cut” para que seja somente recortada e ndo impressa.

Obs.: O resultado da imagem tragada sera afetado pelo contraste e pixels
das imagens importadas. Recomendamos imagens de alto contraste.




3.6 Recorte com o “Sure Cuts A Lot”

3.6.1 Recorte de Imagem

Consulte a Lista de Config. de Parametros de Materiais para a config.
adequada.

El Clique em “Cutter” na barra de ferramentas e “Cut Settings” aparecera.

5.1 Sure Cuts A Lot 4: Untit
File Edit Object Path Layer Page Effects Text View Cutter Window Help

E Clique em “Test Cut” para testar se a config. se aplica ao material escolhido.
Ajuste as configuragdes até encontrar a mais adequada.

s R,

Ql
GCC i-Craft 0123L5€780M00112
Model: [i-Craft - [ settngs... |
Cornection:  [usB - [ Testaut
Port: | <Auto Detect> ~| [@] [restcomnecton]

Settings

Blade Offset: [0.25mm -] oot [go@ene -]

mit-cut: [off =] Qualty: [Fine -

Speedt [ &
Pressure: '—07 14

Ajuste as configuragdes de “Offset” — “Overcut Value” - “Multi-Cut” e “Quality”
na janela de “Cut Settings”.
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GCCiCraft 0123:5678 900112 a
Model: [i-Craft v [ settings... | ' \ B
Connection: [USB v] [ Test Cut ] 01
2
Port: [<Auto Detect> ] [@] [Testconnection] =
5
Cut Settings :
Cut Mode: [~ cut selection only 1%
14
12

Use Software Speed and Pressure [C]mirror H [ mirror v

Preset: [< Custom Preset > v]

Holder: [Advanoed Blade (0.50 mm) N l

[Blade/Pen Prompt

z)
Blade Offset: Overcut: |0.0 (None) %

Speed: {1 - 3
Pressure: {— 4
<[ ’
Print+Cut | [ Savetospcard | [ cancel | [ cut |

Blade Offset: Ajusta o valor de deslocamento da Iamina conforme o tipo
de lamina: Lamina Padrao = 0.25mm - Lamina Avancgada (opcional) =
0.5mm - Caneta de Plotagem (opcional) = Omm.

Quality: Relacionado ao resultado do recorte. Quanto mais lento
recorte melhor sera a sua qualidade.

Multi-Cut: Para repetir o recorte na mesma posig¢ao de recorte de materia
grosso.

Overcut: Permite um arremate mais facil e acerta linhas incompletas de
recorte.

/




Ha fungdes uteis em “Cut Settings”. Apos configurar os parametros,
clique em “Cut” para enviar informacao de operagao.

3.6.2 Impressao e Corte

A funcao “Print e Cut” permite o transito de impressao entre o software “Sure
Cuts A Lot” e a impressora e o posterior recorte pela Plotter.

n Abra um arquivo de imagem no “Sure Cuts A Lot” (Consulte 3.5.1-
3.5.5 para informagéao de procedimento).

Fle ldt Obiect Puh Low Prge Dfech Toe Vaw Cutw Wirdew oy

Cut Settings.

General |

GCCi-Craft

H Model: [i-Craft - [ settings...
Connection: [USB v] [ Test Cut ]
Port: [ <Auto Detect> ] (@] [restConnection]
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Ajuste os pontos de marcacgao na janela de config. Clique em “Preview”
na barra de ferramentas para conferir o posicionamento, o tamanho e a
espessura dos pontos de marcacgao.

Object Path Lsyer Page Effects Text View Cutter Window Help

Show
/ Show Draw Lines
[¥] Show pen colors for Draw lines

[¥] Show Print+Cut registration marks

[7] Show print margins
[] show nodes

E Clique no icone de recorte na barra de ferramentas e estabelecga os
parametros

SetDefaus| [ Cancel | [ _sae ]

41



E Carregue a midia impressa na folha adesiva (consulte 3.3)

-

Cliqgue em “Next” e em “Scan+Cut”.

Print and Cut Print and Cut

. Registration Marks . Registration Marks
Scan for

Reg Mark 1: Static & = Reg Mark 1: Static
Registration Marks
Reg Mark 2: Static Reg Mark 2: Static

RegMark 3: Static Reg Mark 3: Static

Print and Cut
(Auto Scan)
» Position the Carriage so that

it is over the first printad
registration mark at the top-

left of the design.
» If you have not already

printed your design, click the

Print button below to print

vith your printer.

Click Scan+Cut to start the
? You must print using the

Print button below: in order [¥] Use Software Force &Speed [¥] Use Software Force &Speed

to print your artwork vith the
Preset: | < Custom Preset > >

This vill guide you through
the steps needed for doing a
Print and Cut

T Bnt et o Preset: | < Custom Preset > -
Place the printed paper onto

the Cutting Mat and load it

into the cutting machine. Speed: ) 3 Speed: {1} 3
Click the Next button when Pressure: { 45 Pressure: { 45

you are ready to continue

and follow the instructions
o [ Ceen G
| |

42



3.6.3 “Scan2Cut”

Com essa funcgao, as imagens selecionadas podem ser escaneadas ou

fotografadasis1] e depois recortadas.

ﬂ Utilize a caneta marcadora para fazer 4 pequenos pontos de
marcagéo ao redor da imagem a ser recortada para estabelecer o
alinhamento do laser. Cada ponto demarcatoério estabelecera um
canto de uma caixa imaginaria ao redor da imagem a ser recortada.

%

E Capture a imagem utilizando o scanner ou a camera digital.

Selecione “Scan2Cut’.
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| Sure Cuts A Lot 4: Untitled

Edit Object Path Layer Page Effects

New Project
Open Project

Save Project
Save Project As...

Import...
Export...

Ctrl+N
Ctrl+0

Ctrl+S
Ctrl+Shift+S

Ctrl+Shift+I
Ctrl+Shift+E

Trace Image... Shift+B
PlaceImage...

E

[ Somcw. &

FCM Batch Convert...
Send to

eshape Store...
Share Project...
Sync My Library...
Print Setup...
Print...

Recent Projects

Exit

Ctrl+Q

oy gy |




E Clique em “Load Image” para carregar a imagem selecionada.

Scan2Cut

Scan and Cut

This vill guide you through the =
steps needed for setting up a Scan
and Cut. This process vill allow you

to cut around an existing image.

1. Place your image onto your
mat.

i

2. (Optional) Use a pen to make 4
small marks around the imatg
vant to cut which vill bed

Load Image... |

Cancel

44



5 Clique em “Use Custom Marks”. Clique e arraste os 4 pontos de
marcagao para os 4 cantos ao redor da imagem e clique “OK.”

Scan and Cut

This vill guide you through the =
steps neaded for setting up a Scan
and Cut. This process vill allow you

to cut around an existing image.

1. Place your image onto your
mat.

2. (Optional) Use a pen to make 4
small marks around the image you
vant to cut vhich vill be used as 2

< »

Hold down Shift key for smaller

Cancal ) [ previous |

Scan and Cut: Use | | .
custom marks

Click and drag the 4 colored
markers to match up vhere you 2 ks 1.

marked the image vith your pen.
Each corner is designated by a
specific color, so it is important you
align the correct color to the corract
location around the image.

I

When you are done, click OK and
the image should be added to the
workspace. You will then need to
use the Trace Image feature to
make your cut lines. When using
the Trace Imaqe, there is a Crop
« L

Hold down shift key for smaller
ements

E Trace a imagem e recorte.

[cE#BUNON|DRNNe |- 405

e E R

I BTN ON[ERNSo|= 20




3.6.4 Strass

Para criar modelos em strass com o "Sure Cuts A Lot”, selecione um objeto
na area de trabalho e depois “Rhinestones” do menu “Effect”.

[
i# Sure Cuts A Lot 4; Untiﬂ_ # Rhinestone w
e —————

File Edit Object Path Layer Page [Effects] Text View Cutter Window Help
7 e o=, 3 )

e — StoneSze  PeardPlate  mm nch
g - i : [ 3D Rotate -
z i SS 000 PP1 0.80 -0.50 0.032-0.035
o] — LA Barrel Distortion 5500 P2 0.90 - 1.00 0.035-0.039
AaE B Bulge 5500 3 1.00- 1.10 0.039 -0.043
ss1 PR g 1.10-1.20 0.043 -0.047
Eaned 52 s 1.20-1.30 0.047-0.051
Knockout ss2 PP6 1.30-1.35 0.051-0.053
Lattice... I SS3 PR7 1.35-1.40 0.053 -0.055 A
e me +a0 i50 noEs nosn
LineFill

- Stone Size: 1.50 & mm [ Fill shape with stones

Object On Path
Pierce Stone Spaang: 2.00 2 mm Stone count:

Puzzle Generator ‘W :
Rhinestones... a I (, i I

= ¥ P |7

a

| preven | (o ][ ox ]

| f S— . =

Q 2 Shadow Layer (Contour Cut) ...

Title Crawl l
i i Wave i
Ve Wrapper
& |,

3.6.5 Ponta de Gravacao (Opcional)

Para utilizar a ponta de gravacéo, siga as instrugdes abaixo:
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X 100110 120130 140150 160170 150190200210220230 240250 260270250 290300
Lyl S O Y T S 5 O e e e

7 1 Sure Cuts A Lot & i<Craft.scutd

File Edit Object Path Layer Page Tet View Cutter Window

Heip
3D Rotate
Barrel Distortion
Bulge
L.
—

Canned

| Line Fill |
Pierce
Puzzle Genesator
Rhinestones..,

Shadow Layer (Contour Cut) ...
Title Crawl

Selecione o icone de recorte na barra de ferramentas e selecione
“Holder” para estabelecer o posicionamento. Quando estiver
utilizando a ponta de gravagao, selecione “Advanced Blade”. No caso
de caneta para colorir, selecione “Pen”.
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General

GeCicraft

Model: [i<raft - [ settings... |
Connection:  (UsB - [ Testcut |
Port: [ <Auto Detect> ] (@] [restconnection]
Cut Settings

T — Y

[¥] Use Software Speed and Pressure [CiMirrorH - [CMirror v

Preset: [< Custom Preset > -
g T — e

Regular Blade (0.25 mm)
Advanced Blade (0.50 mm)

Recomendamos estabelecer “3 times” para o “Multi-Cut” e “50” de
“Pressure” quando estiver utilizando a ponta de gravagao.

Ci s
General

GCCiCraft
Model: [i-Craft -

[ settngs... |

Connection: ~ [usB v [ testcut |

Port: [ <Auto Detect> ] (@] [restconnecton]
Cut Settings

e — e

[¥] Use Software Speed and Pressure [CIMirrorH [ Mirror v

Preset: [« CustomPreset > v
Holder: (< Custom CutPreset > -
[BledePen pPrompt x)
Blade Offset: [0.0(None)  v|  Overaut: [0.0(None) v
Tl R —
Speed: N
| pressue: N % |
 Print+cut | [ savetospcard | [ cancel | [ cut |
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3.6.6 Caneta para Colorir (Opcional)

Para utilizar o conjunto de Caneta para Colorir e Suporte, siga as
instrucdes abaixo:

ﬂ Coloque a caneta (diametro da caneta entre 8-14mm) no
seu suporte. Certifique-se que a ponta da caneta toque a
base. Empurre a parte superior da caneta e prenda o
suporte simultaneamente.

ﬂ Substitua o suporte da lamina pelo suporte da caneta.
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ADV. SETT
SO EWRLE”
mHOLDER : BLADE

POWER SAVING:OFF

BACK:M 40K ¢

[ Sclecione “PEN” e a folha adesiva ird se movimentar 5 centimetros
para tras. O carro de recorte estara na posicao correta.



ﬂ Selecione, na barra de ferramentas, o objeto a ser desenhado, depois
selecione “Draw (Pen)” em “Cut Line Type” sob a coluna “Style”.

FPCEITION & SIZE
x: 057in & F " ° ;\g
Y: 0.402in - R $
ren O |- @DE
; ||||||||‘|||||||| HAﬁgn: =170 Pae v
s [
i z ég
. mEE Y
T‘ 1_: Style: [Normal ]
& 2] [Flweld
x Cutton o
s T -
7 | = TN f‘\j
Selecione “Pen/Tool (0.00 mm)” sob o0 menu “Holder” na janela

“Cut Settings” e clique em “Cut” para desenhar.
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Cut Settings

oo e
—
GCC iCraft 0123456789101 x
Model: [i-Craft - [ settngs.. | ) E l
Connection: [usB - [ testout |
Port: [ <Auto Detect> ) [&] [restcomection]
Cut Settings
uros oty

Use Software Speed and Pressure [CiMirorH [ mirror v

penLiool0.00mm),
Regular Blade (0.25 mm)
Advanced Blade (0.50 mm
Pen / Tool (0.00 mm

< Custom Cut Preset >

b wone) -]
MultiCut: [off v Quaity: [Fine -
Speed: s ~ 15amfs
Pressure: i} g e
printtcut | [ savetofie | [ caneel | [ cut |

Quando a Plotter terminar o desenho, selecione
“‘BLADE” sob “Holder Settings” no painel de controle

e substitua o suporte de caneta pelo suporte de
ldmina para recortar.

] Selecione “Shadow” sob o menu “Style” e selecione “Cut”
sob o menu “Cut Line Type” A linha de recorte ficara prox.
ao desenho.

Selecione “Regular Blade (0.25mm)” sob o menu
“Holder” na janela “Cut Settings” e clique em “Cut”.



General
GCC iCraft 012345678 91001112

Model: [i-Craft

Connection: [USB

Port: [ <Auto Detect>

Cut Settings

Cut Mode: @ Cut selection only

[¥] Use Software Speed and Pressure [C]mirror H [T Mirror v

Preset: | < Custom Preset >

Holder: |Regular Blade {0.25mm

Advanced Blade O. 50 mm)
Pen /Tool (0.00 mm)
Blade Offset: ‘< Custom Cut Preset >

st
Speed: -~ il s
Pressure: -~}

3.7 Videos Tutoriais na Internet

Ha videos tutoriais na internet em (http://www.craftedge.com/tutorials/) ou
(http://www.gccworld.com/goods.php?act=view&no=63) e ainda a funcéo “Help”
que auxiliam na utilizagao do software “Sure Cuts A Lot”.

= A T
File Edit Object Path Layer Page Effects Text View Cutter Window
= About Sure Cuts A Lot 4...
(<03 g |
!;G E L Help F1
Online Forums
Online Video Tutorials... I

Install Driver...

Support 4

Register Product
Check for Updates

Deactivate...
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3.8 Recorte via Tablet

Veja fungdes basicas do “Sure Cuts A Lot” abaixo. Caso
necessita de instrugcbes detalhadas consulte o “Sure Cuts A
Lot iPad Help”. E possivel consultar as instrugcdes do SCA
versao PC, porém, nem todas as fungdes poderao ser
executadas no tablet.

n Faca o download, na Apple Store, e instale o app “Sure Cuts A Lot”.

1 Habilite o Wi-Fi no AirPort Express™.

Wi-Fi

Wi-Fi (‘;

| ~ Apple Network edebba W = f‘i“:l

Abra o app “Sure Cuts A Lot” e importe uma imagem.

il
3 b
T *
218 I-Craft 2
af7M Al
al =]

i L2
ne—

E Clique no icone “Cutter” na barra de ferramentas.

File Edit Object Path Page Cutter

NE] 2R A e
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E Clique em “Connection” em “Cut Settings” e selecione “Air Print”
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Cralt Settings

Connection Alr Print

<Auto>
Port acr

GCC i-Craft
CUT SETTINGS
Cut Mode WYSIWYG
Holder Blade
Mutti-Cut off
SPEED AND PRESSURE
Use software speed & pressure 0
Materal < Custom Presets > + —
Speed

Cancel Cut
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E Ajuste a velocidade e pressao e clique “Cut.”

Cut Settings.

CUTTER

Model

Port

CUT SETTINGS

Cut Mode

Craft Sewings

A Print

6CC 1Crah c Test Connection

WYSIWYG

Blade

on

SPEED AND PRESSURE

Use software speed & pressure

< Custom Presets > + -

5

Aguarde aprox. 30 segundos para que as informagdes sejam

enviadas a Plotter.
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Cut Session
Cutting data was sent to the cutting

machine

OK;

4. Instalacao e Operacao do Driver

A Plotter estabelece a comunicagdo com um computador
via driver USB (Universal Serial Bus). Este capitulo
mostra como estabelecer a intercomunicacdo com os
softwares de computagao grafica, tais como o CorelDRAW
e o Adobe lllustrator.

é Caso esteja utilizando o Windows 7 ou + recente,
certifique-se de fazer o log in utilizando o

“Administrator Account”

4.1 Instalacao do Driver

n Faca a conexao



1. Ligue a maquina.
2. Conecte o cabo USB e dé um duplo clique no icone

USB na barra de tarefas para certificar-se que o
dispositivo USB foi detectado.

2@PMOEI@ Ul 1332

Your device is ready to use

USE Printing Support o Readyto use
Mo Printer Attached +f Ready to use

P Press. Feed/ Eject O)

Clique em “Install Driver” (Win. 7 ou + recente) no
DVD, e o driver USB sera instalado automaticamente.
Leva alguns segundos para o dispositivo ser
encontrado. NAO DESCONECTE o cabo USB até
concluir a instalagao.
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()

@RAFT A

www.GCCworld.com * = « Ne. 1 choice for micre-business

* Video

a=-=-\ * i-Craft™
-1 | % Software

w o @
-, Craft " Dri

cO’ Install Driver (Win 7 and Above)

@O0 % Ins Clipart Library
" AAS Offset Test Files

+ Back mc“&

Vist i-Craft website http://www.gccworld.com//goods.php?act=view&no=47 for more project video tutorials

A instalagao leva alguns minutos para ser concluida
e aparecera a mensagem em letras vermelhas.
Caso esteja usando o Windows 7 ou + recente,
clique na mensagem para receber instrugdes de
como desabilitar a atualizagdo do Windows para
uma instalagdo bem sucedida do driver. Clique em
“OK” para prosseqguir.

| Windows 7 and above users please follow this

Step by step instruction

0 disable VWindows Update 10 allow successﬁ)\ ‘
dmver installation

Thank e
s Cox]

Certifique-se que a plotter esteja ligada a rede de
energia e conectada ao driver USB e clique em “OK”.

Please make sure the cutting plotter is powered on
and connected to the USE device.
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Certifique-se que todos os aplicativos estejam

fechados antes de iniciar a instalacdo do driver e
clique em “OK”.

Itis strongly recommended that all running application programs
are dosed before you start installing the driver.

Adicione o i-Craft™ driver e clique em “OK” para prosseguir.

' GCC Driver Installation

EX8

Add i-Craft_1 Printer driver Successfully

Caso queira instalar o AASII VBA no CoreIDRAW e no

Adobe lllustrator, saia do CorelDRAW e do Adobe
lllustrator e clique em “Install’.

Welcome to the instalier for AAS Il VBA on
CorelDRAW version 11 12 13 14 1516 17 18 and
Adobe lRustrator CS3 CS4 CS5 CS6 CC

It is strongly recommended that you exit

CorelDRAW and lllustrator program before
continuing

ﬂ Verifique a mensagem de instalagdo para confirmar as versdes do
CorelDRAW e do Adobe lllustrator e clique em “OK”.
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el Message T e

Corel Message
Install CorelDRAW 17.0 GCCAASII_Draw.gms successful

AI Message
AI Plug-in not find

Kl A instalacso do driver esta concluida.

Obs.:

[} O AASII VBA é um plug-in do CoreIDRAW e do Adobe lllustrator para
que o contorno de imagens impressas tenho um
melhor resultado caso escolha operar o arquivo
grafico através do driver GCC.

[} Caso o driver esteja sendo instalado pela segunda vez, o

usuario sera questionado se é necessario uma

segunda cépia da instalagéo do driver.

Em caso afirmativo (“Yes”), uma segunda cépia sera
instalada

4.2 Desinstalacao do Driver

A verséao anterior do driver instalado no PC deve ser
removida antes da instalagdo da versdo mais recente. Siga
as instrucdes a seguir:

ﬂ Va a janela “Control Panel\Hardware” e “Sound\Devices
and Printers”. Clique com o botao direito na impressora
e selecione “Remove device.”



( v ’g.ﬁ » Control Panel » Hardware and Sound » Devices and Printers »

Addadevice  Addaprinter  Seewhat'sprinting  Manage default printers  Print server properties  Remove device =IRe
4 Devices (3)
ity e
MARKET-EILEEN USB OPTICAL USB2.00.3M
MOUSE WebCam
4 Printers and Faxes (9)
o N Ny “ el &
Adobe PDF Bullzip PDF - Kyocera Microsoft XPS SHARP S Z OneNote €325 on 3 See what's printing
Printer FS-2025D@4F-Z  Document Writer ~ MX-M4SOU@F-3 2010 Marcom-marco | AR
) ) i as default printer
e Printing preferences
4 Unspecified (1) . 2 ,
Printer properties
Create shortcut
Troubleshoot
i-Craft Properties

Remove Device

./ Are you sure you want to remove this device?
=

i-Craft

E Apoés a remocgao, clique em uma impressora e

“Print server properties” (Win. 7 ou + recente).
ou dé um clique com o botéo direito no espaco em branco e
selecione “Print server properties” (para Windows XP).

Addadevice  Addaprinter  Seewhat'sprinting  Manage default printers | Print server properties | Remove device

4 Devices (3)

Ny ?

'MARKET-EILEEN  USB OPTICAL USB2003M
MOUSE WebCam

4 Printers and Faxes (8)

- -

® §

Adobe PDF Bullzip PDF

Kyocera Microsoft XPS SHARP {32 OneNote EEZon
Printer FS-2025D(4F-Z  Document Writer  MX-M4S0U@F-2% 2010 Marcom-marco |
RE) )] m

Selecione a pag.” Driver”



=

/= Print S'erver:Pvroperfis (23]

WSIPNIS anvers lSectny IMVBDOEG|

Forms on: MARKET-EILEEN

Delete

Save Form

Farm name 10,1

[ Create a new form

iting the existing name and

Form

E Selecione o modelo e cliqgue em “Remove”.

(= Print Server Properties [3m]
[ Fomms | Pots | Drivers | Securty [ Advanced |

;! MARKET-EILEEN

Installed printer drivers:
Name Processor Type
Adobe PDF Converter x64 Type 3 - User Mode
Bullzip PDF Printer 64 Type 3 - User Mode
Bullzip PDF Printer xB86 Type 3 - User Mode
HP Color LaserJet 2800 Ser... x64 Type 3 - User Mode
i-Craft 64 Type 3 - User Mode
Kyocera FS-2025D KX x64 Type 3 - User Mode
Microsoft XPS Document ... x64 Type 3 - User Mode
Send To Microsoft OneNo... x64 Type 3 - User Mode
SHARP MX-M450U PCL6_T1 64 Type 3 - User Mode

[ Add... ] & Remove... ] [ Properties J

] Change Driver S!ttings

E Selecione “Remove driver and driver package” e clique em “OK”.
: Remove Driver And .lsackage

Do you want to remove the driver(s) only, or remove
the driver(s) and driver package(s) from your system?

() Remove driver only.

@ Remove driver and driver package.

OK Cancel

E Clique em “Yes” e depois em “Delete” e “OK,” e o driver sera
removido.
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-
Remove Driver Package

Driver package information collected.

- . The following driver(s} wil be deleted:
Print Server Properties (2% Craft (x54)

Deleting this printer driver package will
remove it from the system. Are you sure
you want to delete i-Craft?

[ves,][\No] MEKIWI

Remove Driver Package

Driver package deleted.

Driver i-Craft was removed.

4.3 Operacao do Driver

Recorte com aplicativo
(usando CoreIDRAW como exemplo)

El Selecione “Print” sob “File” no aplicativo para recortar a imagem.




ﬂConeIDPAWX? (64-Bit) - Untitled-1

File Edit View Layout Arange Effects Bitmap
New... Chrl+N - H
New from Template... 0

Open... Crl+Q il Hje
Open Recent »

[ &

Close

Close All

Save As.. Ctrl+ Shift+5

o)
&
B Seve- Cirles
[~}
k"

Save as Template...

Acquire Image »
H Search Content
g Import.. Ctrl+l
3, Export.. Ctrl+E
Export For »
Send To ]

|E Print... Ctrle P I
T TeTge

[, Print Preview...
&y Collect For Output...

E%  Publish to PDF
Publish Page to ConceptShare...

fa
[H Document Properties,..

=

Exit Alt+F4

ﬂ Selecione a impressora i-Craft e clique em “Preferences” para
estabelecer os
parametros de recorte.

Print X
General lCoIor I Composite | Layoutl Prepress l 17 No Issues
Destination
Printer: [i-Claft v] [ Preferences... ﬂ\
Page: [Match orientation (Portrait) v] Use PPD
Status: Ready
Location: USB001
Comment: | Print to file
Print range Copies
@ Current document () Documents Number of copies: 1 =
) Current page Selection ! !
Pages: 1 ‘ﬂ Collate
Even & Odd
[T Print as bitmap: 300 ~| dpi
Print style: [CoreIDRAW Defaults V] [ Save As... ]

[ ok J[ Concel J[ Appty |[ hew |

Selecione a midia e “Advanced Settings” para
estabelecer os parametros de recorte. Vocé pode
salvar, importar e deletar os parametros de recorte.



GCC..

SELECT MEDIA

Paper MEDIA SIZE

&
Canvas .i v ,
;eal 1rfmsfer OVERCUT
agne
Cardstock & 2t
Printable tattoo paper DIECUT
Customized 1* ’. =
Customized 2* L
Customized 3* SCALE
Customized 4* +‘ v
REPEAT
Import 3 Delete = C -

GCC AAS Installer Advanced Setting

Save Cancel

Select Media: Escolha do material a ser utilizado.

Media Size: Seleciona o tamanho da midia ou vocé
pode clicar em “Pencil” para editar o
tamanho desejado.

Overcut: Use 0 menu suspenso para
habilitar/desabilitar a funcao.

Diecut: Use 0 menu suspenso para habilitar/desabilitar a funcao.

Scale: Estabelece um num. adequado para ajustar a proporc¢éao de
uma imagem.

Repeat: Estabelece um num. adequado para ajustar a quantidade de
copias de uma
imagem.
Na pagina de “Advanced Settings” os usuaros podem ajustar
valores de velocidade, pressao, qualidade, overcut e diecut.

Cliqgue em “Save as” para salvar as alteragdes para uso
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futuro, ou clique em “Save” para sobrepor configuragdes de
paramétros atuais.

GCC..

ADVANCED SETTINGS ﬂ“q RAFT ™

Speed (1:10) Reset to Default J

"Pressure (1-70)

Tool Select I
Quality
- Cut Test [
Overcut (). ———

*Die Cut

sy DIE CUT ,J,mss Cur

Length Length mm

Pressure | Pressure

Reset to Default: Para dar um reset nas configuragdes de
parametros da

midia escolhida para o valor padrao.

Tool Select:  Para estabelecer a ferramenta adequada ao uso.
As opcodes sao:
“Standard Blade”, “Advanced Blade” e “Pen”.

Quality: Relacionado ao resultado do recorte. Quanto mais
lenta a velocidade de
recorte melhor a qualidade final.

Cut Test: Efetuar recorte teste para verificar se as configuragées
precisam ser
alteradas.

Overcut: Permite um arremate mais facil e compensa linhas
incompletas de recorte.

Die Cut: Para recortar a parte de tras do material.
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4.4 Contorno da Imagem Impressa Via Software de Aplicativo

Consulte as sec¢des 6.3 e 6.4 para instrugdes de recorte de
contorno via CorelIDRAW e Adobe lllustrator AAS plug-in.

5. Utilizacao do Drive USB com a i-Craft™

A i-Craft™ aceite a maioria dos Drives USB. Armazene os
arquivos no formato .plt para que a i-Craft™ possa reconhecer
0S arquivos.

Abaixo estdo os Pen drives que testamos com a GCC i-
Craft™. Recomendamos que utilize as marcas que tenham
o formato FAT32 ou FAT16, outras configuragbes podem
apresentar problemas de compatibilidade.

Marca Memoria Formato
HP 16GB FAT32
SanDisk 16GB FAT32
PNY 8GB FAT32
Kingston 8GB FAT32
Kingston 16GB FAT32
Transcend 4GB FAT32
Transcend 16GB FAT32
Transcend 16GB FAT32
ADATA 8GB FAT32
ADATA 32GB FAT32

5.1 Leitura do USB Drive na i-Craft™
Insira o USB Drive no slot enquanto a plotter estiver conectada a
energia e carregue a midia.
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5.2 Configuracao do USB Drive

As configuragdes “Origin settings”, “Advanced settings”,
“Media”, and “USB Drive” aparecerao na tela. Pressione as
setas de direcdo para cima ou para baixo no painel de
controle para movimentar o ponto de marcagdo e
pressione “Enter” para acessar o menu de configuracgoes.

Main Menu

e0xrigin settings
Adv. settings
Media:Vinyl

USB Drive

5.2.1 Como Recortar Via Drive USB

ﬂ Prepare o material a ser recortado.

E Acesse “Main Menu” na tela e pressione as setas
da direita ou da
esquerda para selecionar o material a ser
utilizado. As opcgdes sao:
vinil, cartolina, transfer térmico, papel de tatuagem
e manta magnética
(usaremos vinil como exemplo). O paréametro
padrao (Default) esta
disponivel a todos os materiais.

Execute o teste de recorte para verificar se os
parametros precisam ser ajustados. Para
executar um teste de recorte movimente o ponto
de marcacao até “Cut Test” e pressione “Enter”.



As configurag¢des serdo mostradas como aparece
abaixo. Utilize as 4 setas de diregdao para
determinar a posicéo inicial e pressione “Enter”
para executar o teste de recorte. Caso seja
necessario abortar o processo pressione “Pause”

Cut test
Set the start point
A
>
< »
v
Ok:e

E] Caso necessario, ajustes os valores de config.
Utilize as setas de

diregdo para cima/para baixo para selecionar as
configuragcdes de midia

escolhida e pressione “Enter”. Para alterar as configuracdes
selecionadas.

Clique em “Pause” e retornara ao topo da pagina. A seguir
damos um

exemplo utilizando config. de velocidade:

Zpeed setting
Fy

L2 —

v
Back:n Ok: <

Selecione o arquivo do drive USB e pressione as setas
para cima/para baixo para escolher as configuragdes e
pressione “Enter”. Para alterar as configuragdes escolhidas
pressione “Pause” e retornara ao topo da
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e0rigin settings ©

Main Menu Fil
|

=CL

S o Back: Il A ¥ Ok:d
®
- ®
5.3 Func¢ao Menu
5.3.1 Menu de Midia
Menu- Midia Funcéo Configuragoes
Speed Determina/modifica a veloc. de movimentagao| 1-10
horizontal do carro de recorte.
Determina/modifica a pressdo de recorte.
Pressure Certifique-se que o material pode ser| 1-70
transfixado.
Over Cut Gera sobre recorte para facilitar o arremate. | 0.00mm-1.00mm
Determina/modifica a qualidade do recorte.
Ao recortar letras pequenas, use “Fine”. Ao _
Quality recortar em alta veloc. use “Draft”. Obs.: ao Draft” - “Fine
recortar em alta veloc. a qualidade pode ser
comprometida.
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Seleciona a Ferramenta instalada no carro de

Tool Select recorte.

Laminas:“Regular”
“Advanced”
e Funcao “Pen”

Cut Test Executa teste de recorte conforme as

configuracdes estabelecidas.

5.3.2 Menu do Drive USB

Menu Drive USB Funcéao Configuracoes
Select file Seleciona o arquivo salvo no Drive USB. N/D
Scale Determina a escala da imagem. 25~200%
Re-cut Repete o recorte na posicao atual. 1-99
Copies Faz copias dos trabalhos 1-99

6. Anexo

6.1 Especificagées da i-Craft™"

de Midia

Modelo i-Craft™
Método Operacional Roller-Type
Largura Max. de Recorte 30.5cm (12")
Comp. Max. de Recorte Até 1000mm
Larg. Max. de Carregamento 330mm (13")

Larg. Max.de Recorte de Midia

32 cm (12.48")

Quant. de Rolos de Pitada 2
Espessura Max. de Mat. 0.8 mm (0.03")
Pressao Vertical de Recorte 5~350 g

Veloc. Max. de Recorte

300 mm/sec (12ips)

Sobre Recorte

Sim

Repeticdo e Copia

Sim
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Compensacgao

0~1.0 mm (com aumento de 0.025 mm)

Buffer de Memoria

32 MB

Interfaces USB 2.0 (Full Speed), USB Flash Drive (FAT16 / FAT32)
Resolugao Mecanica 0.05 mm
Resolugao de Software 0.025 mm

Precisédo de Distancia

10.254 mm ou +0.1% de mov. (o que for maior)

Repetibilidade 0.1 mm
Painel de Controle Painel LCD
Diametro da Ldmina 2.5 mm

Fonte de Energia

Adaptador AC, 24V DC (1.67A)

Consumo de Energia

Max. 40 watts

Sistema de Alinhamento
Automatico

Sistema de Recorte de Contorno Completamente
Automatico — da Impressao ao Recorte

Compativel com Windows 7 e acima & MAC OS X 10.6 e acima. (*Utilizando “Sure Cuts A Lot”

software p/Mac OS.)

N&o ha garantia que todos os pen drives possam ser lidos.

Pode haver variagbes de especificagdes e da “data sheet” com diferentes materiais utilizados.

Faca a manutencédo da maquina de forma regular e adequada.

A GCC reserva a si o direito de modificar as especificagdes a qualquer momento sem

notificagéo prévia.

O material certificado pela GCC é o Avery MPI 3000.

As especificagbes acima somente serdo efetivas quando da utilizagdo de midia certificada

pela GCC.

6.2 Lista de Config. de Parametros de Materiais

Config. de Referéncia para Materiais Diferentes

’ Ima Suave
MIDIA Cartolina Cartolina Cartolina Papel (0.2mm)

(espessura) (1201b.) (2501b.) (350Ib.)* Copia

PRESSAO 14 31 45 14 38
VELOC. 3 3 5 3
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Lamina

Lamina Lamina Verde Lamina Lamina
OFFSET Regular Regular Avancada Regular Regular
(0.25) (0.25) (Opcional) (0.25) (0.25)
(0.5)
Folha de Folha de
- ¢ Vil Transfer |Impressao
MiDIA ranster vt Térmico de
(espessura) Térmico Sinalizacao Tat -
P (0.2mm) (0.18mm) | (0-2mm) | Tatuagem
(0.22mm)
PRESSAO 21 15 24 27 -
VELOC. 5 5 5 -
Lamina Lamina Lamina
OFFSET Lémi”g;egmar Regular Regular | Regular .
0.25) 0.25) (0.25) (0.25)

v' Configure o “Multi-Cut” em “2 times” e substitua a lamina padréo pela lamina

opcional verde para materiais espessos.

v' Os valores de pardmetros acima s3o utilizados em materiais certificados pela

GCC.

v' Os valores de pardmetros sdo somente para referéncia. Os usuarios deverao
fazer ajustes de acordo com os projetos graficos.

6.3

Instrucoes para o CorelDRAW AAS Plug-In

O AASII Plug-in é uma funcéo de recorte de contorno para
imagens impressas para operar com softwares graficos
tais como CorelIDRAW e o Adobe lllustrator, sendo uma
solugdo alternativa ao software “Sure Cuts A Lot”.

v O AASII VBA Installer é aplicavel ao CoreIDRAW Verséo X3-X8




75

Instalcao
Consulte a etapa 8 da Secao 4.1 “Instalagcao do Driver”, para instalar o

AAS plug-in para CoreIDRAW.

Exec. do CorelDRAW AAS Plug-in

El Execute o CoreIDRAW para editar as imagens e
selecione todas as imagens de uma sé vez para a
plotagem.

E Selecione “Tools>Macros->Run Macro.” Depois selecione
“Global Macros” (GCCAASII_Draw13.gms) sob o
manual “Macros in” e clique em “Run”.

rRun Macro @‘
Macro name: Run
GCCModule GCC _A8% Plug In
Create
Macros in: | GlobalMacros (GCCAASII_Draw.gms) v‘
Description:
GCC's AASII Contour cutting System VBEA
Clique em “Apply” e escolha se quer acrescentar
pontos de marcagao por tamanho de pagina ou por

objeto.



AAS T Reg. Mark Setting v2.09-01 X

[V Add Registration Mark by page size
r

% 4-Point Position

Length 25 mm (5-50)
Thickness 1 mm (1-2)
Margin 0 mm (0-50)

(" Segmental Positioning

X Ste
P| 500 mm (200 - 600)

Y
Step| 500 um (200-600)
P
No. of X Copies [ { (1-50)
No. of Y Copies | (1-50)
™ Copies with outline

Apply | Cancel |

ﬂ Agora vocé pode imprimir o arquivo de imagem com os pontos de
marcagao.

Obs.: “Add Registration Mark by Object” sera a escolha default se
clicar na imagem, enquanto “Add Registration Mark by page

size” sera a escolha default se clicar na area em branco da
pagina

Vocé pode acrescentar um icone para o AAS Plug-in

Selecione “Tools> Options> Workspace—> Customization—->
Commands—>

Macros> GCCMadual.GCC_AAS_Plug_In” e clique em OK.

Options x

Commands

Geners! | Shortcut Keys | Appearsnce

Toaltsp Help

A co Mlumber

[ Gl Sratecros L o3t i

‘ﬁ GECModuIeGCCARS L] | ey Avstable On
A Weard CreateCalendar

LY CorelDRAW X7 (64-Bit) - Untitled-1
File Edit View Layout Arrange Effects Bitmap

" E ®- H
E 85" v|[a
[Lel'ter "‘ 0110" ar Oic
[+ | Welcome Screerf p tled-1
d | wanitodia M ]
B |
fw, &

(o) [ Concel Help ",
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Acrescente Pontos de Mrcacao por tamanho de pagina

Caso marque “Add Registration Mark by page size” conforme
mostrado abaixo e clicar em “Apply”, os pontos de marcagao
serao criados automaticamente (Veja figura A3-1)

|

Obs.: [ AAS I Reg. Mark Setting v1.02-01
1. A config. de comprimento sera de
5-25mm, conforme o tamanho da pagina. ¥ Add Registration Mark by page size
.
2. Nao faca nenhuma alteracéo a secao =
“Origiri ao acrescentar os pontos de marcacgao. - EW

Thickness 1 mm
Margin 0 mm

P
Xstep 300 o
| YStep| o3pp

Options X
Si to Objects »
s Rulers £
Warnings
VBA
Nud: - .
. udge No. of X Copies |
D GiGITRGE Nudge .01} —_ Supernudge: 2 | x0010in P
8 ) ) . o. of Y Copies
Plug-Ins aches Micro nudge:  0.010in/ 2 |2 1
= Text
- Toolbox 7| Same units for Duplicate distance, Nudge and Rulers r CODiES with outline
1 Customization
Command Bz Units
Commands Horizontal: inches o2
Color Palette
5 Document E Aeely = ‘
General 3 [¥] Same units for Horizontal and Vertical rulers
Page Size -
Layout Origin Tick divisions: i
Lasel W 3 e Figura A3-1
Bockground orizontal: — inches — pertick
=}- Guidelines Vertical: 0.0 = inches | Show fractions
Grid
Eijers 7] Show Rulers [ EditScate.-
Save R,
Export To HTML
#- Global =
« i »
OK Cancel } Help

Figura A3-2



Print

© O

W B D
o) of B

C :’3‘ ;-j‘:-: »é
@ Figura A3-3

Area de Trabalho
Permite que os usuarios editem as imagens e fagcam os

recortes na area fora dos pontos de marcacédo quando os
pontos de marcacgao forem acrescentados por pagina.

Para folhas tamanho A4, a area de trabalho € de 2.5mm,
extendida do ponto de marcacgao dos lados esquerdo e
direito e de 4.5mm extendida do ponto de marcacéo da
parte de cima. Sugerimos deixar pelo menos 25mm de
margem no lado de baixo.

Para folhas tamanho A3, a area de trabalho € de 10mm,
extendida do ponto de marcacao do lado esquerdo, de
9mm, extendida do ponto de marcacao do lado direito e de
11mm, extendida do ponto de marcagao do lado de cima.
Sugerimos deixar pelo menos 25 mm de margem no lado
de baixo.

General | Color | Composite | Layout | Prepress | 17 Nossues|

Destination
Printer: [\\gpprinter2\4F_E 28 5 KYOCERA FS-2025D KX - [ Ppefeences.. | |
Page: [Match orientation (Landscape) vJ Use PPD L— Left side j
Status: Default printer; Ready
Location: 192.168.100.246 H
Comment: [ Print to file : X
: o) o (“ H
- - Top side: m EY: 38 ide!
Print range Copies I PR =44 v Buttom si e
; = H N - H
@ Current document Documents Number of copies: 1 = ' 2
°) Current Select E (é‘ :
urrent page Selection : ’ 3 -
1 2 ' S 1 N F
Pages: 1 @ ! Collate H L ) -
Even & Odd @ Right side J
[T Print as bitmap: 300 dpi Origin
Print style: [CoreIDRAW Defaults vJ [ Save As... ]
Page 1l ¥
Print Preview oK | [ Cancel |[ Apply |[ Hep |
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Acrescente o Ponto de Marcacao por Objeto

AAS Il Reg. Mark Setting v1.02-01

==

‘“- Add Registration Mark by page size

AAS I Reg. Mark Setting v1.02-01

S

A g
[ Add Registration Mark by Object

{* 4-Pgint Position

Thickness 1 mm
Margin 0 mm

" segmental Positioning

X Step 500 -

Ystep[ 500 .-

" Multiple Copies

No. of X Copies | 1
No. of Y Copies | 1

[ Copies with outline

Cancel

Apply

.| SpTo- W £ Q-
S W SDmm =
™ 2 G spmm ~

7

9

|
2é.
@
| o
B & X tone
Figure A3-6

v

£ I co Mo YO K10 050 pt



25mm 5mm

Tamanho Comprimento Sugerido

A6 (105 x 148)
A5 (148 x 210)
A4 (210 x 297) 11
A3 (297 x 420) 16
A2 (420 x 594) 23 1
A1 (594 x 841) 25+

AAS T Reg. Mark Setting v1.02-01 ==

I™ Add Redistration Mark :
W Add Registration Mark by Object

" 4-point Position
Length 25 mm

Thickness [1—mm hdow  Hep .. = J_
—gn [5—- -= == . POsicionamento

s v] @ o0imm 3 gei0mm j:?‘
@+ segmental Positioning
xstep[ 200 /
Y Step| app b

(" Multiple Copies . o Vn 8 s ?
No. of X Copies |1— b ‘f‘( ‘ @ ARy Y“ v
No. of Y Copies |1_ & @ q
™ Copies with outiine g‘ # @ @

Apply | Cancel l f s g @ %

- — | 1 L
* [Figure A3-9

» 4 G
(174517,30398) [B] @ & X None & o M0 Y0 X100 0.500 pr

Figure A3-10
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O Posicionamento Segmental sera aplicado a multiplas copias quando o objeto a ser
copiado for grande (comprimento ou largura acima de 200mm). O procedimento visa
aumentar a precisao de detecgao do ponto de marcagao.

Copias Multiplas

Sugerimos selecionar “Multiple Copies” ao fazer varias copias de uma imagem para

aumentar a precisao de recorte.
[ AAS I Reg. Mark Setting v1.02-01 (o]
|
[V Add Registration Mark by Object o
(" 4-Point Position
L th
‘ eng [Tmm
Thickness [1_mm
Margin [0—’""‘
| (" Segmental Positioning
Y Stey [— Help &
| P] 500 mm ® P 3 sapTe [ =]
* Multiple Copies | ¥ 01mn '4‘: fﬁ i =
No. of X Copies [T > ;
No. of Y Copies [—;— - L L L j
I Copies with outline m, m Qﬁf’ QQ
Apply | Cancel | | | I
~ e - — s L— e
o} . . - ww ®®
=" Figura X3Ufif E i E E
. | | |
S
o hoid e b s
AL o o b, b
« Ll | LI L]
: t r
B4 1ot b @] Pael 5 =
»# X X axis
(-20.536,345479) [B @ & X None & o M0 v X100 0.500 pr
Figura A3-12

Recorte de Contorno Com o CorelDraw

ﬂ Coloque o material impresso com os pontos de marcagao na Plotter.

] Selecione “Files>Print”.
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5 CorelDRAW X7 (64-Bit) - Untitled-4
File  Edit Layout  Object
Ctrl+N

View
New...

New from Template...

L & A=

Open... Ctrl+0

Open Recent
Close
Close All
Ctrl+S
Ctrl+Shift+S

Save...

Save As...

FnD 33

Save as Template...

AcquireImage
Search Content
Import...
Export...

Export For
Send To

Ctrl+1
Ctrl+E

o %

Publish to PDF
Publish Page to ConceptShare...

Effects

Bitmaps Text Table Window Help
¥ G B = | fe

0o fol o Units[milimeters_~] 4 01mm [

» ed-2  Untitled-3  Untitled-4

Tools

4% SnapTo ~ [ £

&, 50 B |
%50mm G Ik

- 0

1 C -
L L

[f]r®

Print... ctip |
Print Merge »
(& Print Preview...
4s  Collect For Output...
1 Document Properties,..
B Exit Alt+F4
I
E 4 4 1ofl » b B Pagel |« T

v
(133911, 453.218) ]

Figura A3-13
Obs.:

1. Clique na pagina “Color” e va para “Color conversions performed by:”

FLECERNFLASEHNPOO OGS OAS

illimeters

B M ¢ 10of1
(-128.179, 316.087) b

| General | Color | Composte | Layout | Prepress | (s Mo Issues

(@ Print composite
O Print separations

(@ Use document color settings
(O Use color proof settings

Color conyersions performed by:

Convert spot colars bo RGE

Carrect colors using color profile: |(Document) sRGB IEC61966-2.1 v

Rendering intent: |Relative colorimetric v/

iy The colr settings and preview avalable in this dialog box are set for the Windows Graphic
device printer that you selected on the General tab.

B

[ PrintPreview pint | [ cancel [ apply | [ Heb

Object Manager »
Layer:
Layer 1

m

B (] Page 1
* @ #M Cuss
@ — @M Clone Layer
8 * — @M Mark Layer

8 @ — ¢l Layer 1
[ Rectangle
B [_] Master Page
* G #M Cuos
* @ ¢M Dskvp
~%@ G

» ¥ B Pagel s i |

@
| 2

(@
99@
WX

Document color profiles: RGB: sRGB IEC61966-2.1; CMYK: Japan Color 2001 Coated; Grayscale: Dot Gain 15% P

Text Properties
= 11 ) @&

- —
2 Character Al
£

AN scripts B E
3

2

2

O Avial - &

u,

Ay -

oo | -
T
- X [ -

A TR

ab, X, Q, AB

Bo o Fo oW

Ao S,0 Ao goa
filtr@ostofsof ol
B0 ¥, ¥.o0 & o 6§

A Paragraph

El = =

€ 00mm |3 =

B 00mm [ -

& [ C:0 M0 Y:0 K100 0500 pt

Siga as instru¢des abaixo para utilizar o CorelDraw X5 ou versdo mais recente.

[

Figura A3-14
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% CoreIDRAW X5 - [Untitled-1]

B File Edit View Layout Armange Effects Bitmaps Text Table Tools Window Help

(B =0 ~ = B -0 @ey DE [ snapto v &
210,
—,Dm @u lum mm - %
ol R »
£ Layer:
[ Layer 1
il B ] Page 1
AR Print X * @ 4 Gudss
q b 5 — @ o @I Clone Layer
5 b General | Color | Cumpusite‘ Layout | prepress | (2 No Issues | B * — @M Mark Layer
Meut Image position and size
Oﬂ & © Asin document
B O Fit to page.
k Include marks and calibration
Ol @ ooiting .
s Reposition images to:
Q& (=) Settings for Page 1:
LR Position: Sige: Scale factor:
| xi 2148w a| e [117.200v 4] 100 v 4 |% @
et yi |655.02 v ~ | F [111.381% « | [100 % B (1 2 ¥ — ¢ Layer 1
=25 ” [ Rectangle
4 [Jerint tiled pages s B [_] Master Page
Ll ; @ 4 Cudls
ol Tile overlap *@ oM Dskvp
o e “2®@ Gud
Ty = [Cleleed limit:
o Imposiion layout: | As in document (Full Page) v [ ed. ]
8, ¢
& F [ PrintPreview ] () [ pint ][ cancel | [ apob [ nep |
s
> |
AR

B4 10f1 > M B Pagel | HES) I J
(-128.179, 316.087) »
Document color profiles: RGB: sRGB IEC61966-2.1; CMYK: Japan Color 2001 Coated; Grayscale: Dot Gain 15% P

&
g Lk

OQB

X
|

=
i

=%

2. Va para a pagina “Layout” e selecone “Reposition images to”
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6.4 Instrucoes para uso do lllustrator AAS Plug-In

AASII VBA Installer se aplica as versdes CS4, CS5, CS6, CC.do Adobe lllustrator.

Instalacao
Consulte a etapa 8 na segao 4.1 “Instalacéo do Driver” para instalar o AAS plug-in

para o Adobe lllustrator.

Configuracao da Impressora

ﬂ No Painel de Controle, clique com o botao direito na impressora e selecione
“Printer Properties” para abrir a pagina.



&5

- » Control Panel » HardwammdSmnd » Devices and Printers »
= =

Add 2 device

= =
Add a printer See what s printing Manage default printers Print server properties Remove device

4 Devices (2)

MARKET-EILEEN USB OPTICAL
NB

MOUSE

4 Printers and Faxes (9)

%ﬁggdwg

wh( s ptinﬁq
4F_4 \%ﬂ_ﬁﬂi AF_FJE_=H Adobe PDF Bullzip PDF i-Craft Microsoft XPS Set a5 default printer
_KYOCERA Printer Document Writer
AR-| mso PCL6  F5-2025D KX on Printing preferences
on gpprinter2 gpprinter2 Printer properties o
w
Create shortcut
Troubleshoot
Remove device
Froperties

Va para “Advanced page” e certifique-se que a caixa “Enable
advanced printing features” ndo esteja marcada.




g RXII-1325 Properties - - (S

Pen | P | AAS Installer
General | Shaing | Ports | Advanced | Color Management | Securty | Options

@ Always available

@ Available from 12:00 AM = To 12:00 AM
Priority: 1 ot
Driver: |Rx@-1325 ~|| NewDriver..

@ Spool print documents so program finishes printing faster

(7) Start printing after last page is spooled
@) Start printing immediately

() Print directly to the printer

[ Held mismatched documents
[] Print spooled documents first

[ Keep printed documents

[ Enable advanced printing features

[ Printing Defaults... H Print Processor... H Separator Page...

ok J[ cancel |[ sepy |

Instrucoes de Uso

ﬂ Abra o “lllustrator”.
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E Edite a imagem e crie uma linha de contorno. (Obs.: a largura da linha deve
ser de 0.001mm).

Contorno

Clique na imagem e aplique a fungao AAS (File>Scripts>_AASII_Plug_In)

New...

New from Template...
Open...

Open Recent Files
Browse in Bridge...
Close

Save

Save As...

Save a Copy...
Save as Template...
Save for Web...

Save Selected Slices...
Revert

Place...

Save for Microsoft Office.
Export...

Scripts

Document Setup...
Document Color Mode
File Info...

Print...

Exit

CtrieN
Shift+CtrleN
Ctrl+O

»
Alt+Ctri+O
CtrlW
Ctries
Shift+Ctrl$
AltCtrl+S

Alt+ShiftsCtrl+S

F12

» ExportDocsAsFlash
Flex Skins

Alts Ctrl+P
»
Alt+Shift+ Ctrl+1

ImageTracing
SaveDocsAsPDF
SaveDocsAsSVG
Ctrl+P | _AasiPlugin N
CtrieQ

Other Script... Ctri+F12
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Make by Page size

¥ 49ant Poisitoriny |

X Step{men):

¥ Stepme).

Mutigie Copies |

No. of X Copies: _ (
Mo.of YCopes: [N (150)

Copres with cutine

Execute

oy




" € 100% (CMYR/Preview)

BE m G pasinde

Make by Page size

¥ 4-Point Poisitioning |
tength(mm):  [CHEEN (10~50)

Thickness(mm): (1~2)
Margin(mm): - (0~50)

Segmental Poisitioning |

xstepm):  ETIEEN (200~600)
Ystep(mm): VRSN (200~600)

Multiple Copies |

No. of X Copies: _ (1~50)
No. of Y Copies {1~50)

Copies with outiine

Cancel

Swatches

89




90

Clique na area em branco e depois em “Document Setup”.

File Edit

No Selection -

T°f Transform
|== Align

Fy Pathfinder

hep 0 M

% (CMYK/Preview) X

v ste: [l

Document Setup




Bleed and View Options

Units: | Points v Edit Artboards

Right
Bleed: 5 |

Show Images In Outline Mode
Highlight Substituted Fonts
Highlight Substituted Glyphs

Transparency
Grid Size: Medium

Grid Colors: |l Light

Simulate Colored Paper -

Preset: [Medium Resoluti

Type Options
v Use Typographer's Quotes

Language: ' English: USA
Double Quotes: =™ v Single Quotes:

Position
Superscript: f

Subscript:
Small Caps

Export: Preserve Text Editability

Cancel

Clique em “Presets — Fit Artboard to Artwork bounds”.
File Edit

Artboard

357 [ cor
Fit to Artwork Bounds

E
v Letter

Legal

s
/| Tabloid
/

ol A4
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Clique em “Selection Tool”

g
1-F Transform

s Align

Pathfinder




Open...

Close
Save
Save As...

Revert

Place..

Export...
Scripts

File Infe...

New from Template...

Save a Copy...
Save as Template...
Save for Web...
Save Selected Slices...

Save for Microsoft Office...

Document Setup...

Open Recent Files

Browse in Bridge...

Document Color Mode

Alt+Shift+Ctrl+ S

Alt+Shift+ Ctrl+]

Help
Ctrl+N
Shift+Ctrl+N
Ctrl+0
»
Alt+Ctrl=0

Ctrl+W
Ctrl+5
Shift+Ctrl+S
Alt+Ctrl+5

Aft+Ctrl+P

»

Print...

Ctrl+P

Exit

Coloque o arquivo impresso na Plotter, abaixe os rolos de pitada e posicione
o carro de recorte na origem dos pontos de marcagao.

Ctrl-Q

Envie o arquivo para a Plotter.

Edit Object Type
New...
New from Template...
Open...
Open Recent Files

Browse in Bridge...

Close

Save

Save As...

Save a Copy...

Save as Template...
Save for Web...

Save Selected Slices...

Revert
Place...

Save for Microsoft Office...
Export...

Scripts

Document Setup...
Document Color Mode

File Info...

Ctrl+N
Shift+Ctrl+N
Ctrl+0

Alt+Ctrl+0

Ctrl+W
Ctrl+S
Shift+Ctrl+S
Alt+Ctrl+S

Alt+Shift+Ctrl+S

F12

Alt+Ctrl+P

Alt+Shift+ Ctrl+1

»

»

Window Help B
i | .

Print...

Ctrl+P

Exit

Ctrl+Q
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Selecione o modelo da Plotter, posicione o objeto no canto inferior esquerdo

Print_

General

Marks and Bleed

Qutput

Graphics
anagement

Summary

Print Preset:

Printer:

General

Copies:

Artboards:

Media Size:

Orientation:

Options

Print Layers:

Custom

RXII-1325

Ignore Artboards v Skip Blank Artboards

Defined by

Visible & Printable La

Placement: 8

Scaling:

Do Not Scale

Scale:

Done Print

Cancel




Acrescente Pontos de Marcacao por Tamanho de Pagina

Para criar pontos de marcagao por tamanho de pagina selecione o objeto, va para
“ AASII_Plug_In”

“Scripts” sob

Edit Object Type
New...
New from Template...
Open...

Open Recent Files

Browse in Bridge...

Close
Save
Save As...
Save a Copy...
Save as Template...
Save for Web...
Save Selected Slices...
Revert

Place...

Save for Microsoft Office...

Export...

“File” e

Eff

Ctrl+N

Shift+Ctrl+N
Ctrl+0

Alt+Ctrl+0

Ctrl+W
Ctrl+S
Shift+Ctrl+S
Alt+Ctrl+S

Alt+Shift+Ctrl+S

F12

»

Window Help =

Scripts

|

Document Setup...
Document Color Mode
File Info...

Print...

Exit

Alt+Ctrl+P

Alt+Shift+ Ctrl+I
Ctrl+P

Ctrl+Q

»

Flex Skins
ImageTracing
SaveDocsAsPDF
SaveDocsAsSVG

[—— oo

Ell.ai* @ 74% (CMYK/Preview) X

ExportDocsAsFlash

I

_AASI Plug_In

Other Scriot...

Ctrl+F12

¥ Make by Page size

¥ 4-Point Poisitioning |

Length(mm):

Ell (00
Thickness(mm): (1~2)
S -0

Segmental Poisitioning |

Margin{mm):

X Step{mm):

EZI (200~500)
(200~600)

Y Step(mm):

95




96

Ctrl+N
New from Template... Shift+Ctrl+N
Open... Ctrl+0
Open Recent Files »
Browse in Bridge... Alt+Ctrl+0

Ctrl+W
Ctrl+S
Shift+Ctrl+S
Alt+Ctrl+S

Close
Save

Save As...

Save a Copy...
Save as Template...
Save for Web...

Alt+Shift+ Ctrl+S

Save Selected Slices...

Revert F12
Place...

Save for Microsoft Office...
Export...

GreatCut 3

Scripts ExportDocsAsFlash
Document Setup... Alt+Ctrl«P Flex Skins »
Document Color Mode » ImageTracing
File Info... Al Shift+ Ctrl+1 SaveDocsheRbr
SaveDocsAsSVG
pan Skl _AASILPlug_In
= Gy Other Script... Ctrl+F12

Marks and Bleed
Qutput

Graphics

Color Management
Advanced
Summary

Print Preget: | custom v &

Printer: | Jaguarlv-101 vl

PPD:

Gereral

Copies:

[CReverse Order
®al [Jignore Artboards

Range: [ I Skip Blank Artboards

— Media
Size:

To

L

W 4 1of1(1)

Width: o | Height:

— Options
Placement: 387 X [0pt | ¥ jopt |

(%) Do Mot Scale
(OFit to Page  (483.8058%)

(O Custom Scale: W o H:
OTile FL Overlap:
H:
Tile Range: I ]
Print Layers: IVisibIe & Printable Layers ¥ |

[ pint ) [ cancel | [ Done |




¥ 4-Point Poisitioning |

Length(nm): LTI (19~s50)
Thickness(mm): 1~2)

Margin{mm): _ {0~50)

Segmental Poisitioning |

X Step(mm): (200~600)

YStep(om):  EVENEN (200~600)

Multiple Copies |

No. of X Copies:
No. of Y Copies: _

Copies with outline

Make by Page size

# 4-Point Poisitioning |
tengthtom): R (10~50)

Thickness(mm): _ (1~2)
Margin(mm): I o0

Segmental Poisitioning |

X Step(mm): B (200~500)
Y Step(mm): m (200~600)

Multiple Copies |

No. of X Copies: (1~50)
No. of Y Copies: _ (1~50)

Copies with outline

Exeatte ————————

97

Posionamento
[ Comprim.: O comprim. dos pontos
> Alcance: 5Smm~50mm
> Config. Otimizada: 25mm
) Espessura: A espessura dos pontos
> Alcance: Tmm~2mm
> Config. Otimizada: 1Tmm
) Margem: A dist. entre os pontos e as
linhas
- Alcance: 0Omm~50mm
> Config. Otimizada: 5mm



Obs.:
1. Para salvar materiais, alterar as margens e ajustar o comprimento dos pontos

de marcagao (minimo de 5mm) quando utilizando o “4-Point Positioning”.
Quanto menor o tamanho, menor sera a distancia entre o objeto e os pontos
de marcacao (veja as ilustragdes abaixo).

Area de Recorte

5mm
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4-Point Poisitioning |

Length(mm): E (10~50)
Thickness(mm): _ (1~2)
Margin(mm): I o0

' Segmental Poisitioning |

X Step(mm): B (200~500)
Ystepm):  ETVHENN (200~600)

Posicionamento

Copias Multiplas
Sugerimos selecionar “Multiple Copies” ao fazer varias copias de uma imagem para
aumentar a precisao de recorte.
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4-Point Poisitioning |

tength(nm):  FEHNNNN (10~s0)
Thickness(mm): 1~2)
Margin{mm): _ (0~50)

Segmental Poisitioning |

X Step(mm): B (200~600)

Y Step(mm): (200~600)

¥ Multiple Copies |

No. of X Copies: _ (1~50)
No. of Y Copies: _ (1~50)

Copies with outline

Exeaute

Apply
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